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LEGAL NOTICES

THIS DOCUMENT CONTAINS CONFIDENTIAL AND TRADE
SECRET INFORMATION OF FOCUS ENHANCEMENTS AND
ITS RECEIPT OR POSSESSION DOES NOT CONVEY ANY
RIGHTS TO REPRODUCE OR DISCLOSE ITS CONTENTS, OR
TO MANUFACTURE, USE, OR SELL ANYTHING THAT IT MAY
DESCRIBE. USE IN WHOLE OR IN PART WITHOUT THE
SPECIFIC WRITTEN AUTHORIZATION OF FOCUS
ENHANCEMENTS IS STRICTLY FORBIDDEN.

EVERY EFFORT HAS BEEN MADE TO ENSURE THAT THE
INFORMATION IN THIS DOCUMENT IS COMPLETE AND
ACCURATE AT THE TIME OF PRINTING; HOWEVER, THE
INFORMATION CONTAINED IN THIS DOCUMENT IS SUBJECT
TO CHANGE.

Copyright 2006 Focus Enhancements
All Rights Reserved

The material contained in this document is also protected by
copyright laws of the United States of America and other
countries. It may not be reproduced or distributed in any form by
any means, altered in any fashion, or stored in a data base or
retrieval system, without express written permission of FOCUS
ENHANCEMENTS.

FOCUS ENHANCEMENTS cannot be responsible for
unauthorized use of equipment and will not make allowance or
credit for unauthorized use or access.

ProHD DR-HD100 Portable DTE Recorder



Contacting FOCUS ENHANCEMENTS:

Office Hours:

Email:
Telephone:
Fax:
Address:

Monday through Friday
8:00 AM to 5:00PM (Central Time)

support@focusinfo.com
763-398-1658
763-571-7688

Focus Enhancements, Inc.
1370 Dell Avenue
Campbell, CA. 95008
www.focusinfo.com
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Regulations and Safety

Focus Enhancements, Inc.
1370 Dell Avenue
Campbell, CA. 95008

Model Number: ProHD DR-HD100

Date of Manufacture:
Reference the Serial Number label attached to
the unit.

Serial Number

The serial number for this equipment is located on the back of the
unit. Please write this serial number on the enclosed warranty
card and keep it in a secure area.

FCC Class A

This product satisfies FCC regulations when shielded cables and
connectors are used to connect the unit to other equipment. To
prevent electromagnetic interference with electric appliances
such as radios and televisions, use shielded cables and
connectors.

This equipment has been tested and found to comply within the
limits for a Class A digital device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide reasonable
protection against harmful interference in a residential
installation. This equipment generates, uses, and can radiate
radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference
to radio communications. However, there is no guarantee that
interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or television
reception, which can be determined by turning the equipment off
and on, correct the interference by one or more of the following:

» Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and
receiver.

» Connect the equipment to an outlet on a circuit different from
that used by the receiver.

» Consult the dealer or an experienced radio/TV technician for
help.
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Symbol Used In the ProHD DR-HD100 Unit

This symbol indicates the presence of an uninsulated

A Dangerous Voltage within the product’s enclosure that
may constitute a risk of electric shock to persons.

Symbols Used in This Documentation

This symbol indicates important information that the User
should read.

This symbol indicates supplemenatry information about
features, functions, or operations that may be of interest to
the user.

Documentation

Read, Retain, and Follow Instructions
All the safety and operating instructions should be read before
the product is operated.

* Retain Documentation
Place documentation in a secure place for future reference
on operating and safety instructions.

* Follow All Operating and Safety Instructions

+ Pay Attention to All Warnings
Warnings are provided to protect the operator, the
equipment, and content.
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Electrical Precautions

Do Not Expose to Moisture

Do not use this product near water or in an environment where it
is exposed to dampness or there is the possibility of it getting wet.

Do Not Remove Cover

There are No User Serviceable Parts inside this unit. Servicing
should be done by qualified service personnel.

ON / OFF Switch in Stand-By Position

The On/Off switch Does Not Separate the Unit From the Main
Power when it is in the stand-by position.

Power Sources

Use only power sources that match those indicated on the
marking label. If unsure sure of the type of power supply that is
available, consult your dealer or local power company.

Do Not Overload Power Outlets

Do not overload wall outlets, extension cords, or integral
convenience receptacles as this can result in a risk of fire or
electric shock.

Verify Power Plugs are Fully Inserted

To prevent potential electrical shock to personnel, verify that the
DR-HD100 power cord plug is fully inserted in to a grounded
receptor and that the plug blades are not exposed.

ATTENTION

POUR PREVENIR LES CHOCS ELECTRIQUES NE PAS
UTILISER CETTE FICHE POLARISEE AVEC UN
PROLONGATEUR, UNE PRISE DE COURANT OU UNE AUTRE
SORTIE DE COURANT, SAUF SI LES LAMES PEUVENT ETRE
INSEREES A FOND SANS EN LAISSER AUCUNE PARTIE A
DECOUVERT.

Power-Cord Protection

* Routing Power-Cords
Route power supply cords so that they are not likely to be
walked on or pinched by items placed upon or against them.
Avoid sharp angles in the cord, particularly at plugs,
convenience receptacles, and the point where they exit the
product.
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* Non-Use Period
During extended periods when the device is not used,
unplug it from the power source and retract the power-cord.

Grounding or Polarization

* Polarized
If this product is equipped with a polarized alternating
current line plug (a plug having one blade wider than the
other), it will fit into the outlet only one way. This is a safety
feature. If you are unable to insert the plug fully into the
outlet, try reversing the plug. If the plug should still fail to fit,
contact your electrician to replace your obsolete outlet. Do
not defeat the safety purpose of the polarized plug.

+ Grounded
If this product is equipped with a three-wire grounding type
plug, a plug having a third (grounding) pin, it will only fit into
a grounding type power outlet. This is a safety feature. If you
are unable to insert the plug into the outlet, contact your
electrician to replace your obsolete outlet. Do not defeat the
safety purpose of the grounding type plug.

Outdoor Antenna Grounding

= pr—— If an outside antgnna
- LEAD 1K WIFE or cable system is
/ GROLNG ?LHE"J’? - connected to the DR-
[l LY - aF i .
= ittt HD100, verify that the
FLECTRC .'.‘ R " )
SERVEE ]_Lf,-j =~ GACIRDING CORDUCTOR antenng or cable
: PO CLANPS sy§tem |s'grounded.
Fig A POWER SEFVIGE GROU KD This provides some
ELECTROOE 5YSTEW . )
T AT 0 PRET H) protection against
BT — RATICOMAL LG TRIGAL S0DE voltage surges and

built-up static charges.

Refer to Article 810 of the National Electric Code, ANSI/NFPA 70,
for information about the proper grounding of the mast and
supporting structure, grounding of the lead-in wire to an antenna
discharge unit, size of grounding connectors, location of antenna
discharge unit, connection to grounding electrodes, and
requirements for the grounding electrode.

Lightning and Power Surges

During electrical storms or when left unattended and unused for
long periods of time, unplug the DR-HD100 from the power
source and disconnect the antenna or cable system.
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Power Lines

Do not locate an outside antenna system in the vicinity of
overhead power lines, electric light or power circuits, or where it
can fall onto such lines or circuits.

When installing an outside antenna system, extreme care should
be taken to keep from touching such power lines or circuits as
contact with them might be fatal.

Optical Precaution

The use of optical instruments with this device will increase
hazards to the eyes hazard.

Maintenance and Moving

Cleaning

Unplug this product from the wall outlet before cleaning. The
product should be cleaned only with a polishing cloth or a soft dry
cloth. Never clean with furniture wax, benzine, insecticides or
other volatile liquids since they may corrode the cabinet.

Servicing
Unplug the device from the power outlet and refer servicing to
qualified service personnel under the following conditions:

When the power-supply cord or plug is damaged.

If liquid has been spilled, or objects have fallen into the
product.

If the product has been exposed to rain or water.

If the product does not operate normally when following the
operating instructions. Adjust only those controls that are
covered by the operating instructions. The incorrect
adjustment of other controls can result in damage and often
requires extensive work by a qualified technician to restore
the product to its normal operation.

If the product has been dropped or damaged in any way.

When the product exhibits a distinct change in performance.
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Accessories and Replacement Parts

Use only attachments and accessories recommended by Focus
Enhancements.

Use only replacement parts specified by the Focus
Enhancements or of comparable quality and characteristics as
the original parts.

Unauthorized substitution of parts can result in fire, electrical
shock, other hazards, and loss of warranty.

Safety Check

Upon completion of any service or repairs to this product, ask the
service technician to perform safety checks to determine that the
product is in proper operating condition.

Operating Environment

Location
Any mounting of this device should follow its instructions, and
should use only mounting accessories recommended by Focus
Enhancements.
» Install this device on a sturdy, level surface, away from
moisture and dust.
* Heat
Locate this device away from heat sources such as
radiators, heat registers, stoves or other electrical devices
(including amplifiers) that generate heat.

Ventilation

Do not block the ventilation openings in the DR-HD100 body.
Overheating can occur and damage the device. Do not place this
device in a built-in installation, such as a bookcase or rack,
unless proper ventilation is provided.
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Introduction

Thank you for purchasing a Focus Enhancements’ FireStore
DR-HD100 portable direct-to-edit (DTE) disk recorder. The FireStore
DR-HD100 is the first portable DVHD disk recorder with DTE
technology designed for hand held camcorders in a small, rugged
and shock proof chassis.

If you edit with applications from Adobe, Apple, Avid, Canopus,
Matrox, Pinnacle, Sony, Ulead, and many others, FireStore's DTE
Technology is the only solution that can save hundreds of hours a year
by recording clips to disk in your non-linear editor’s (NLE) native file
format.

DTE Eliminates Pre-edit Processing

The DR-HD100 DTE disk recorder eliminates the need to capture,
transfer or convert video clips before editing. The DR-HD100 is a
stand-alone device that records DV25, HD 720p, and HD 1080i video
to its disk drive as a NLE native file. In HD Recorder mode it has the
capability of capturing to disk HD 720p and 1080i video from HDV
camcorders equipped with a 1394 interface. For most DV and many
HDYV compatible NLE systems, when the disk drive is connected to a
computer the clips are immediately available for editing. Shoot,
connect, and edit: it is now that easy.

These capabilities make the DR-HD100 the perfect companion for the
JVC GY-HD100/101.
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Unpacking

Verify that the DR-HD100 has the following items:

1. DR-HD100 unit

2. Beltclip

3. User guide

4. Firewire cables, four and one foot long, 6-pin to 6-pin

5. Power cord

6. Power supply with cable and connector to the DR-HD100
7. Removable Li-Ion battery pack

Missing or Damaged Components

If there are missing or damaged items, contact Focus Enhancements
Support for assistance.

Email: Support@focusinfo.com

Telephone: 763-398-1658
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Features

DR-HD100 Features
The DR-HD100 offers the following features:

Tapeless acquisition

Especially equipped camcorders permit the use of Direct To
Edit (DTE) Technology to record directly from a camcorder
while shooting and without the need of a tape.

True DTE Technology
When shooting is finished, connect the DR-HD100 to a

computer and instantly be ready to edit in the timeline. Files
are recorded to disk as

HD Recorder DV Recorder: DV Recorder
M2T AVI Type 1 (NTSC units):

AVI Type 2 AVI Type 2 24p
Avid OMF QuickTime 24p
Canopus AVI
Matrox AVI
Pinnacle
QuickTime
RawDV

DR-HD100 provides support for cutting edge HDV
camcorders with 720p and 1080i MPEG-2 capabilities and
FireWire, 1394, connection.

Fast and Efficient Editing

When shooting is finished, mount the DR-HD100 to a Mac or
PC editing system like a typical FireWire hard disk drive.
Transfer clips to your NLE's media drive at up to 400 Mbps
or edit instantly in real-time using the DR-HD100 as your
media source. With some DV and HDV compatible NLE
systems, it is necessary to capture the video footage using the
NLE system’s capture capability.

Confidence in Recording

Now, simultaneously record to disk and tape while you shoot,

providing an immediately available, drop out free, edit source
with an archive and backup on tape.
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¢ Compact, Lightweight, Rugged Design
The FireStore DR-HD100 weighs approximately one pound
including the battery and is only 1.5" thick. You can mount
the DR-HD100 directly to your camcorder using the optional
camera mount kit, or clip the DR-HD100 directly to your
belt. The DR-HD100 is designed to withstand the rigors of
field shooting. The programmable, 10-second electronic
shock cache ensures that your video is always recorded even
in the roughest of conditions.

¢ Flexible Capacities and Power

The DR-HD100 is available with either a 40GB or 80GB
hard drive that provides a record time of approximately 3 or 6
hours respectively. Extend record times by linking two DR-
HD100 units together.
Power the DR-HD100 using slim, removable battery packs or
power it using the supplied AC adapter.

e [Easy to Use, Control and Update
The DR-HD100 interfaces with your camcorder using a
single FireWire cable that passes audio, video, timecode and
control information. When a tape is present, each press of
start and stop on your camcorder's record button creates an
individual clip on disk. The DR-HD100 features a
comprehensive backlit display, menu system and buttons
allowing easy control and management. In addition, these
units are upgradeable in the field.

* Never Miss A Shot
DR-HD100's ten second retro record mode means you are
always recording. When action happens, you know up to ten
seconds prior to the event occurring is saved in your clip.

» Retro Disk and Loop Record modes.

*  Scene Marking:

This allows categorizing video clips into pre-named folders
on the disk during a shoot.

*  User definable time lapse.
*  Loop playback modes.

*  Free Run, Rec Run, and Regen timecode modes.
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Quickstart

This section provides the following information necessary for using
the DR-HD100 as quickly as possible.

Physical Description and Basic Controls............c...cccceeeeunnnnns 6
The DR-HD100 Menu System ........cccoocivivieiiiiiieeeniiieeeen 14
Connecting the DR-HD100 to AC Power ..........cccccvvvveeeeeenn. 18
Installing / Removing the Battery Pack ...........c.cccccceiinnee. 19
Connecting a DR-HD100 to a DV/HD Camcorder .............. 21
Record and Playback with the DR-HD100 ............ccccevueeee. 22
Power On the DR-HD100 .........coviiiiiiiiieeiieee e 22
Select HDD Recorder Mode ..........cccuiiiiiiiiieieeiieee, 23
Select a DV/HD File Format ........cccovviiiiiiiiiiiee e 24
Set Time and Date ... 25
Record With the DR-HD100 ........cocociiiiiiiiiiiieeeieee e 27
Manual Recording ..........coooiiiiiiiiiiieee e 29
JVC GY-HD ..ot 30
SYNCIO SIAVE ...oiiiiiiiiii e 32
EXternal ... 33
Playback on the DR-HD100 ........c.ccciiiiiiiiiiiieiiiieee e 34
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Physical Description and Basic Controls

Front Panel Controls

§
DTE recunoLosy

LCD
Display

Function
buttons >
A B C
Power ON 4> o) roue ) < Ejt\;ig:;ion
and Reset | \
utton / ), | Transport
Record ) ) 47 Control
Button ) ) buttons
Power OFF AN Speaker
and
Stop button
LCD Display

This is a backlit, 14 character by 7 line dot matrix display.

In event of a mild electrical discharge to the unit the LCD could go blank. To
correct, hold the SELECT button down for 5 seconds.

Function buttons (A, B, C)

Below the DR-HD100 LCD display are three user-defined
function buttons: A (left), B (center), and C (right). Use them as
short-cut keys for the most frequently selected functions at the
bottom of the LCD display. The function of these soft buttons
changes, depending on the options displayed above that specific
button. Refer to the “Functions Screen” on page 70 for more
information.
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Power On Button

The Power ON button provides two functions.

* Power ON

Turn on the DR-HD100.
e Reset DR-HD100

+  DR-HDI100 first must be powered on.

*  Hold down the Power On button for more than one second.
* Power OFF

Hold down the OFF button m for three (3) seconds. During

power off, the DR-HD100 beeps, indicating that it is turning
off.

Alarm OFF
If the Alarm feature is set to OFF, then the power-down sequence
occurs silently.

Navigation Buttons

Use these buttons to navigate through the DR-HD100 menus. The
navigation buttons are Left, Right, Up, Down, and Select.

Transport Control Buttons
Play

Record

Search

Back STOP Forward
Index Power Off Index

Use these buttons to control DR-HD100 playback and record
functions. You usually operate these transport buttons while on
the Home screen.
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Record e

Press this button once when the DR-HD100 is in Stop mode to put the
DR-HD100 into REC-PAUSE. Press it again to start recording. Pressing
the Record button while recording, causes the current clip to close and a
new clip is created without dropping any frames. This button is the only
button that has a red legend on the front panel.

Back Search €4«

Press this button to play video at speeds different than real-time. Refer
to the note in the Forward Search section.

Play »
Press this button to start playback of the selected clip.

Some HDV Camcorders Require a Moment to Synchronize

Some HDV camcorders require a moment to synchronize the video from an
external source. Typically during this period, they display a solid blue or black
video until synchronized.

Forward Search »»
Press this button to play video at speeds different than real-time.

Fast Forward and Reverse
Pressing the Forward Search button multiple times results in increases in the
search speed, i.e. fast forward. This mode works both in forward and reverse
functions. For instance, if you are in 10X FF speed and you press the Back
Search button once, the DR-HD100 is now in 2X FF mode. In addition, this
applies to backward search speeds. The default speed resolution is as
follows (NTSC and PAL have slightly different multiples for < 1X)

» Reverse: -30X, -10X, -2X, -1X (reverse play), -1/2X(-15fps), Still.

» Forward: Still, +1/2X (+15fps), +1X (play), +2X, +10X, +30X

Fast Forward and Reverse Search Compatible Camcorders
In Forward and Reverse Search modes, some camcorders do not display
video when played-back from an external device, such as the DR-HD100.

Search Modes and HD Recorder Mode
Slow-motion Forward Playback and all Reverse Playback search modes are
not available when in HD Recorder mode.
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Back Index | <4«

This button returns the DR-HD100 to the beginning of the current clip
when in playback mode. Press this button twice in sequence to return
the DR-HD100 to the previous clip during playback. In STOP mode,
press this button to return the DR-HD100 to the beginning of the
previous clip.

Ohote

Using Back Index with Short Clips
When using Back Index with short clips, it is first necessary to place the
DR-HD100 in STOP mode.

Pause, STOP m and Power OFF

While in the Home screen, and in any transport mode, press this button
to Pause the DR-HD100. Press it again to stop the DR-HD100. Refer to
the section, “Setup Screens” on page 62 for more information.

To power off the DR-HD100, hold down the STOP button B for three
seconds. During Power OFF and if the Alarm function is ON, the
DR-HD100, makes an audible beep indicating it is turning off.
Forward Index »p|

Use this button to skip forward to the next clip in STOP and PLAY
modes.

ProHD DR-HD100 Portable DTE Recorder 9



Quickstart

Top Panel

The top panel contains the following connectors and LEDs:

Camera

Remote Control (FireWire Connector)

(Serial Connector)

Computer
(FireWire Connector)

Status LED
Charge LED

Table 1: Charge LED States

LED Indicates

Off No Charger Connected

Green Charging Cycle Completed

Amber / Green Floating Charge Mode (Charging almost completed.)
Amber Fast Charge Mode (Maximum charging rate.)

Red Charging Error

Red / Amber No Battery Installed / Battery Error

Amber, flashing Insufficient Voltage to Charger

Table 2: Status LED States

LED Indicates
Off Power OFF
Green Power ON (Power On but there is no activity.)

Orange, solid Playback

Orange, fluttering Hard drive being accessed during playback.
Red, solid Recording Mode

Red, blinking Recording Pause
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Computer FireWire Connector

e In/Out: 6-pin IEEE-1394a port x 1
*  Asynchronous Data I/O

Remote Control, Serial Connector
*  GPI/RS232C; 3.5mm TRS mini jack. (3.5mm to DB-9 cable
accessory available).
*  Configure as a simple contact closure or RS-232C port.
+  Connect an optional wired remote commander.

Camera FireWire Connector

« DV//O

*  6-pin IEEE-1394a connector

»  Isochronous 25Mb/s DV video I/O
DR-HD100 supports 1080i/720p video I/O when used with
HDYV camcorders equipped with a 1394 connection like the
JVC GY-HD100/101.

* DV Audio: embedded 2-channel (48kHz, 16-bit) or 2-channel
(12-bit, 32kHz) audio, 720p/1080i HDV MPEG1 Audio Layer
IL

Ohote

4-Channel Audio
4-channel (12-bit, 32kHz) audio is available only with RawDV
format.

GY-HD10X Does Not Support 1080i
The GY-HD10X companion camcorder does not support 1080i
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Rear Panel

The rear panel contains the following important items:

@

Fan Intake

~q——— Battery

Vent Compartment
Do Not Block Latch
Battery
Compartment

Side Panel

The side panel contains cooling vents as illustrated below.

Cooling Vents

Do Not Block
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Bottom Panel

The DR-HD100 bottom panel features a single 2-pin DC power
connector. Connect the supplied AC power adapter here.

DC Internal
Power Speaker
Connector

—

Cooling Vent
Do Not Block

Internal Speaker
An internal speaker provides alarms and audible feedback.

To disable the audible feedback, go to the Settings menu and
select ALARM OFF. However, the power, temperature, and disk
capacity alarms are always active.
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The DR-HD100 Menu System

The DR-HD100 menu system provides access to all the functions
available in the unit. Each of the screens below (except the Welcome
and Home screens which come up automatically when the unit starts)
are accessed by pressing the Left or Right navigation buttons. The
functions of each of the selections on these screens is explained in
more detail in “DR-HD100 Functions” on page 47.

Olicte

Returning to the Top of Menu or Home screen
To get to the top of any menu, press the Left button. To get back to the Home
screen:

Highlight the screen title at the top of the screen.
Press the Select button.

*  Welcome
Only appears for several seconds upon power up.
* Home

Gateway screen for all functions, it displays disk and
operational status.

e Control
Contains the following selections:
* Local
« JVCGY-HD
*  Syncro Slave
e AV/C

»  External

* Play From
Provides lists to select play material from:
*  Track List

* Reel List
* Play
Contains the following Play selections:
* Play Clip
*  Loop Clip
* Loop All
* Play All

14 ProHD DR-HD100 Portable DTE Recorder
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¢ Reels

Allows selected clips to be marked for placement in
particular Reels Folders.

+ ROO
« RI1
« R22
+ R33
« R44
+ R55
+ R66
« R77
+ R3S
* R99
*  NONE
o Utilities

Contains the following disk and clip functions:
*  Organize Reel
*  Organize OMF
*  Organize PINN
*  Delete Clip
*  Format
*  Repair Disk
*  Repair Clip DV mode only
+ File Name
+  Upgrade
*  System Reset
»  Diagnostic
«  Status
* Functions
Contains user definable function button selections. Changing
a setting with a Function button is identical to changing the
setting in its corresponding menu. Refer to “Functions
Screen” on page 70 for more information.
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e Setup

Contains the controls for setting and reviewing the
DR-HD100 configuration:

Set Date (MM/DD/YY)

Set Time (XX:XX:XX)

View Firmware Version
LCDLight ON

LCDLight OFF

LCDLight AUTO

Alarm ON

Alarm OFF

Stop Frame DV mode only
Stop Gray DV mode only

Stop No Video

EXT CTL OFF

EXT CTL PAUSE

EXT CTL FRAME DV mode only
EXT CTL FILE

TC EXT (external)

TC REC RUN DV mode only
TC FREE RUN DV mode only
TC REGEN (regenerate) DV mode only
TC SET

UB SET

TC DROP NTSC only

TC NON-DROP NTSC only
LCD Contrast

e HDD Mode
Contains the following hard drive selections:

16

DV Recorder
HD Recorder
DD Drive

Use Ext. DR-HD
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e DV orHD Formats

Following HDD mode is a menu of formats available for the
type recorder selected in HDD mode.

When selecting DV Recorder the following formats are

shown:

+ Raw DV

«  AVITypel
«  AVIType?2

*  Canopus AVI
*  Matrox AVI
*  Quicktime
«  Avid OMF
*  Quicktime 24p
*  AVIType 2 24p
* Pinnacle
When selecting HD Recorder the format displayed is:
«  M2T
* Record
Contains the following recording functions:
*  Normal
*  Retro Disk
*  Retro Cache
*  Loop Record
* SNAP DV mode only
* Time Lapse DV mode only
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Powerlng the DR-HD100

The DR-HD100 operation without a battery installed.

To operate the DR-HD100 without a battery installed,
connect the unit to an AC power source.

¢ Before operating the DR-HD100 with battery power.

It is first necessary to fully charge the battery. An uncharged
battery, typically takes 2-3 hours to charge.

Connecting the DR-HD100 to AC Power

Attach the AC power cord to the DR-HD100 (with or without battery
installed). The DR-HD100 is immediately ready for operation.

To do this, connect the AC power as follows:

Battery Pack

DC Cable

DC Power Port

Step 1:  Plug the cord from the power supply into the bottom of the
DR-HD100.

Step 2:  Connect the line cord to the rectangular power supply.
Step 3:  Plug the line cord into an electric outlet.
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Installing / Removing the Battery Pack
Installing a Battery

Battery Gently press DOWN
Latch Hook while sliding battery pack
FORWARD

Latch Slot

Latch \

Step 1: Place the unit, so that the battery compartment is up.

Step 2: Position the battery pack, as shown above, so that the latch
hook is almost in the latch slot, and touching the floor of the
battery compartment.

Step 3: Slide the battery forward while gently pressing down.
Feel the battery slide along guides and seat itself.
Step 4: When seated, the battery latch clicks into place.

Removing a Battery

Step 1: Slide the battery latch to the left and hold.

Step 2: Apply backward pressure to the battery pack at the triangle/
arrow and gently slide the pack back about lcm or 3/8 in.

This is the reverse motion of inserting the battery.

Step 3: Remove the battery pack.
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Charging the Battery

The battery begins charging anytime it is connected to AC power using
the AC adapter supplied with the DR-HD100. The charge LED lights
when the DR-HD100 is charging. For information on the charge LED,
refer to the subsection “Top Panel” on page 10.

Before the battery can be used it must charge until the battery status
LED indicates the unit is fully charged (green).

The Charge LED on the top of the DR-HD100 lights to show
the battery is charging.

An uncharged battery takes 2-3 hours to charge with the unit
powered off.

The battery provided with the DR-HD100 can supply power to
the unit for about 90 minutes while in continuous Record or
Playback mode.

An optional high capacity battery (BATT-0009-01) capable of
providing power for almost three hours of continuous
recording is available from Focus Enhancements.

Using FireWire to Charge DR-HD100

It is possible to charge the DR-HD100 battery through the 1394 port on
a computer provided that the computer outputs at least 15V through the
port. To determine if this is possible, consult the computer’s
specifications.

Battery Use
A Misuse can cause property damage and/or bodily injury such as

burns if a conductive material such as jewelry, buttons, or beaded
chains touch exposed terminals. The conductive material may
complete an electrical circuit (short circuit) and become quite hot.
Exercise care in handling a charged battery, particularly when
placing it inside a pocket, purse, or other container with metal
objects.

i Warning: Do Not Use Unapproved Battery Chargers

Use of battery chargers not approved by Focus Enhancements
could cause the battery to catch fire or explode.

Use Only Original Focus Enhancements FS-BC Battery
Chargers
There are four versions of the optional FS-BC battery charger for
use in various parts of the world.

ASYF-0940-01 USA

ASYF-0941-01  Europe

ASYF-0943-01  United Kingdom

ASYF-0944-01 Australia
These optional battery chargers are available from either your
local dealer or online at the Focus Enhancements web store,
www.focusinfo.com/sales/store.
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Connecting a DR-HD100 to a DV/HD
Camcorder
Before performing this procedure, make sure you have installed and

charged the battery, see “Installing / Removing the Battery Pack” on
page 19.

Step 1:  Connect the supplied Firewire cable to the “DV 1/O” connector
on the top of the DR-HD100.

Step 2:  Locate the FireWire/DV/iLink (or similar) connector on your
video camera. It is located in different places depending upon the
brand of camera. If you are unclear of its location, consult your
video camera manual.

DR-HD100 Supplied with 6-pin to 6-pin FireWire Cable
A 6-pin to 6-pin FireWire, 1394, cable is provided with the
DR-HD100.

GY-HD100/101 FireWire Connector

The FireWire connector on the GY-HD100/101 is located on the
right side of the camera, behind the tape transport. For more
information, refer to the GY-HD100/101 documentation.

Step 3:  Connect the other end of the FireWire, 1394, cable to your video
camera.
Step 4:  Turn on the video camera.

Step 5:  Turn on the DR-HD100.
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Record and Playback with the DR-HD100

Before using the DR-HD100, set up the unit as outlined in the
following sections:

Power On the DR-HD100 .......ccooiiiiiieeeee e 22
Select HDD Recorder Mode .........ccccveveviiiiiieieiiiiieee e 23
Select a DV/HD File Format ........cooooiiiiiiiiiiiiiieeieeeee s 24
Set Time and Date .......ccccoeuviiiiiiiiie e 25
Record With the DR-HD100 .........ccoooiiiiiieeiiieee e 27
Manual Recording ..o 29
JVC GY-HD ..ottt 30
Series Record and Split Slave Control Modes .................... 31
SYNCIO SIAVE ..o 32
EXernal ... 33
Playback on the DR-HD100 .........cccoeiiiiiiieiiiiiiee e 34

The values set in these procedures are fixed and persist through
power cycles. To change them, repeat the steps outlined above.

Power On the DR-HD100

Step 1:  Press the Power ON button for more than one second and release

22

Transport

it.

Power ON Play
(Reset)

Navigation
Buttons

Buttons

OFF (STOP)
To power OFF,
hold down for 3-5 seconds.
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Step 2:  The Welcome screen appears and displays while the
The Home screen appears when the DR-HD100 initializes.

FIRESTORE
DR-HD100

PORTABLE
DTE RECORDER

Step 3:  The Home screen appears when the DR-HD100 first powers up.
For more details about this screen, “Home Screen” on page 49.

B STOP1-

COUNTER T Im
00:00:14:02 4
DISK 1 168 min

REEL
SYNC DISP LOCK

Select HDD Recorder Mode

Step 1:  Press the Right navigation button two times until the HDD Mode
display appears.

HDD MODE

-DV RECORDER
HD RECORDER

DD DRIVE
USE EXT DR-HD

Step 2:  Use the Down navigation button to highlight the recorder mode,
either DV or HD.

Step 3:  Press the Select button on the navigation buttons.
Step 4:  Press the Left button to return to the menu title.
Step 5:  Press the Right button once and advance to the FORMAT screen.
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Select a DV/HD File Format

The formats displayed depend on the recorder mode selected in the
previous step, for example DV RECORDER results in the following:

DV FORMATS
RAW DV

-AVl TYPE1
AVl TYPE2
CANOPUS AVI

Step 1:  Use the Up and Down navigation buttons to select the DV file
format that supports the preferred NLE system. A dash mark to
the left of a list item indicates that it is the current selection. The
default value is AVI Type 2.

DV24p and PAL 25p Modes
24p modes are only for use with camcorder's that are capable of
DV-24p Advanced mode.

PAL 25p camcorders require no special 25p DV format

Check www.FireStore,com for supported Applications
For a complete and up-to-date list of supported applications and
their associated formats, visit the website:
http://www.firestore.com

Step 2:  Press the center Select button on the navigation buttons.

Step 3:  Press the Left button to return to the menu title.

Step 4:  Press the Right button once and advance to the SETUP screen.
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Set Time and Date
Olate

Date and Time Must Be Set

The date and time must be set because they are used in the DR-HD100 file
naming function.

Step 1:  Press the Right navigation button several times until the Setup
display appears on the screen as shown below:

SETUP

09/15/05
11:21:13

VvV 1.0.0
-LCDLIGHT ON

Step 2:  Use the Down navigation button to highlight the date and press
the Right navigation button to access the SET DATE screen.

SET DATE

KX 15/ 05

MM /DD /YY

BACK

Step 3:  Use the Up and Down navigation buttons to change the
highlighted value. Use the Right and Left navigation buttons to
highlight the Month, Day, and Year.

Step 4:  When complete, press the right-most Function button indicated
as BACK on the screen. The new date will be indicated on the
SETUP screen.
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Step 5:

Step 6:

Step 7:

Step 8:

26

Use the Down navigation button to select the time and press the
Right navigation button. The following screen appears:

SET TIME

K 21:13

HH: MM : SS

BACK

Use the Up and Down navigation buttons to change the
highlighted value. Use the Right and Left navigation buttons to
highlight the Hour, Minute, and Second. (Time is indicated in
24hr. mode.)

Press the right-most Function button indicated as BACK on the
screen. The new date appears on the SETUP screen.

The Time and Date are now set.

Press the Left navigation button followed by the Select button to
return to the beginning screen.

For more information on the Setup function, refer to the section,
“Setup Screens” on page 62.
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Record With the DR-HD100
There are four modes of recording with the DR-HD100.

Manual Recording
Control with the DR-HD100 transport buttons.

JVC GY-HD

This recording mode is tailored for use with the companion,
JVC, GY-HD100/101. Set the JVC GY-HD100/101
camcorder’s 1394 REC TRIGGER to SYNCRO, SPLIT, or
SERIES to enable control of the DR-HD100.

Syncro Slave

Use this mode with camcorders that do not have DR-HD100
compatible external control or tapeless trigger functionality.
In this mode, the DR-HD100 watches the record status of the
camcorder and replicates its actions. A tape must be in the
camcorder for this mode to function.

External

Control recording with other camcorders that have
DR-HD100 compatible external control or tapeless trigger
capabilities.

Before beginning recording, verify that:

1.
2.
3.

Time and date are set.

Recording format is set.

The DR-HD100 is connected to the video camera according
to the explanation in “Connecting a DR-HD100 to a DV/HD
Camcorder” on page 21.

Camera and DR-HD100 are powered on.

Tape is loaded in the camera.

Ohote

External Control

If the camcorder supports an external control function, then tapeless
recording is possible. Otherwise, the DR-HD100 control panel keys
must be used to control recording in LOCAL control mode when there
is no tape in the camcorder.

For a list of compatible camcorders, go to Focus Enhancements
website at http://www.focusinfo.com.
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A Do Not Disconnect Power or FireWire Cable

28

Never disconnect the power or the FireWire cable during a
recording. This will cause file corruption.

Loss of Power During Recording

If power is lost during recording it is possible to repair the
damaged file or files, refer “Repair Disk” on page 78 to and
“Repair Clip DV Mode only” on page 79.

Troubleshooting: Counter Not Incrementing

If the Counter does not increment while recording from the camera, it is
an indication that there is no active connection between the DR-HD100
and the camera.

» Verify that the DR-HD100 1394 DV 1/O and the camera
connections are secure. It may be necessary to unplug and then
reconnect them.

When a good connection is made, the Counter increments and
recording starts.

Verify Record Mode Matches Source Video Content and Format

If in DV Recorder mode, HD content will not record properly. ANTSC or
PAL DV source records only on a matching NTSC or PAL unit.

Short Delay When Switching from VTR to Camera Mode

When switching a camcorder from VTR to camera mode, there is a
short (10-20 seconds) interval while the DR-HD100 re-establishes
communications with the camcorder. If recording is started during this
period, recording is delayed until the DR-HD100 finishes establishing
communications with the camcorder.

The DR-HD100 will NOT record a new clip if there are
approximately two minutes, or less, space remaining on the
internal disk drive.
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Manual Recording

Step 1:
Step 2:
Step 3:

Set the video camera to Camera or Cam mode.
Verify that an image appears in the viewfinder.

On the DR-HD100, press Record ® once.
This sets the DR-HD100 to Record-Pause mode.

Record ®¢ ——====iG")

Step 4:

Step 5:
Step 6:

Step 7:
Step 8:

Stop W (OFF)

On the DR-HD100, press Record ® button a second time.
The DR-HD100 begins to record. The timecode value is
displayed on the screen.

Press Stop B (OFF) once to return the DR-HD100 to
Record-Pause mode.

Press Record ® and the DR-HD 100 begins to record again
on the same clip.

Press Stop B (OFF) twice to stop the recording.
Press Record ® twice to begin recording a new clip.

Creating a New File without Dropping Frames

When in record mode, it is possible to break the recording into a
separate, new file without dropping frames.

Press Record ® and the DR-HD100 automatically creates a new clip.

ProHD DR-HD100 Portable DTE Recorder 29



Quickstart

30

JVC GY-HD

The JVC GY-HD control setting is the preferred mode when
using the companion GY-HD100/101 camcorder.

Important GY-HD100 Setting
When simultaneously recording to both tape and the DR-HD100, be certain
to set the GY-HD100’'s OTHER— BACK SPACE [HDV] Menu selection to

P-1394.

With this setting there is a slightly delayed response to the record trigger.
However, when OTHER—BACK SPACE[HDV] is set to P-TAPE, the stream
that the DR-HD100 records will contain discontinuities at every point that
recording to tape is initiated. This will result in the loss of content.

Step 1:

Step 2:
Step 3:

Step 4:

Step 5:
Step 6:

Step 7:

Place the GY-HD100/101 into SYNCRO mode from the
camcorder’s 1394 REC TRIGGER menu. Refer to the
camcorder manual for details.

Verify that the DR-HD100 is in STOP mode.

From the DR-HD100 Home screen, press the Right
navigation button several times until the CONTROL screen
appears:

CONTROL

LOCAL
-JVC GY-HD

SYNCRO SLAVE
AV/C

Use the Down navigation button to select JVC GY-HD. The
dash on the left side of an item indicates it is the current
selection. The default value is Local.

Press the Select navigation button.

The beginning screen returns and a Pause indicator
appears in the upper left-hand corner. Next to this symbol,
is aJ indicating that GY-HD100/101 is now controlling the
DR-HD100.

Now the DR-HD100 will respond to the camcorder’s
record/record-pause trigger.
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Series Record and Split Slave Control Modes

Two additional control modes are available when the DR-HD100
is teamed up with the JVC GY-HD100/101 camcorder: Series
Record and Split Slave. To access these control modes, select
either Series or Split mode from the GY-HD100/101 camcorder’s
1394 REC TRIGGER menu. The DR-HD100 must be in JVC GY-HD
mode for these modes to function, see “JVC GY-HD” on page 30.

Series Record

Series Record automatically starts recording to disk when a tape is close
to the end of the record session. For more information about what
happens once recording to disk begins, refer to the camcorder
documentation.

Split Slave

In Split Slave mode, the GY-HD100/101 camcorder controls the DR-
HD100 separately from the camcorder’s tape transport. The DR-HD100
is slaved to the camcorder’s REC TRIGGER button, located on the
GY-HD100/101°s left panel.

»  Every time the Rec Trigger is pressed, the DR-HD100 begins
recording in the selected recording mode.

*  When the Rec Trigger is pressed again, the DR-HD100 enters
REC/PAUSE mode. The only exception is if it is in Retro
Record mode.

*  Pressing the Rec Trigger a third time, restarts recording. A
new track is created on the disk. Refer to camcorder
documentation for more information.

Ohate

GY-HD100 OTHER—>BACK SPACE[HDV] Setting

When using this mode, be certain to set the GY-HD100/101’s
OTHER—BACK SPACE[HDV] menu to P-1394.

With this setting there is a slightly delayed response to the record
trigger.However, when OTHER—>BACK SPACE[HDV] is set to P-
TAPE, the stream that the DR-HD100 records will contain
discontinuities at every point that recording to tape is initiated. This will
result in the loss of content.
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Syncro Slave

CONTROL

LOCAL
JVC GY-HD

-SYNCRO SLAVE
AV/C

This mode is for camcorders that do not have external control or
the tapeless control functionality compatible with the DR-

HD100.

*  Syncro Slave mode requires that a tape be in the camcorder
for operation.

e The DR-HD100 must be set to Syncro Slave control mode.

¢ In this mode, the DR-HD100 watches the record state of the
camcorder and follows its actions.

When Synchro Slave mode is entered from the menu, the Home
screen appears with the Pause indicator displayed in the upper
left-hand corner along with a Y that indicates that the DR-HD100
is following the camcorder’s record state.

Step 1:
Step 2:

Step 3:

Step 4:
Step 5:

Step 6:

Verify that the DR-HD100 is in STOP mode.

From the DR-HD100 Home screen, press the Right
navigation button several times until the CONTROL screen
appears:

Use the Down navigation button to select Syncro Slave.
The dash on the left side of an item indicates it is the current
selection. The default value is Local.

Press the Select navigation button.

The beginning screen returns and a Pause indicator
appears in the upper left-hand corner. Next to this symbol,
is a Y indicating that DR-HD100 is now following the
record state of the connected camcorder.

Now the DR-HD100 will record at the same time the
camcorder records to tape.
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External

CONTROL

JVC GY-HD
SYNCRO SLAVE
AV/C

-EXTERNAL

Use the External control mode with camcorders that are
compatible with DR-HD100 external control or tapeless
operation capabilities.

*  When the DR-HD100 is in External mode, an E displays
along with the tape state, indicating that the unit is in External
mode.

*  Use the camcorder’s REC button to Start and Stop the DR-
HD100 tapeless recording.

*  The camcorder’s External control or tapeless trigger function
must be enabled for this mode to work.

Refer to the camcorder User Manual for more details.

Recording Timecode in the File

Select EXT TC in the Setup menu. This option records the video
camera timecode in the file. There are other timecode options
available, refer to TIME CODE on page 66.

Function buttons

The tasks discussed above are available for programming into the function
buttons. For information on setting up function buttons, refer to the section,
“Functions Screen” on page 70
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Playback on the DR-HD100

Verify that both the video camera and the DR-HD100 are powered on
and that they are connected together with the FireWire cable from the
DR-HD100 DV/IO port to the camcorder 1394 port.

Feature Availability on PAL Cameras
This feature is not available on some PAL cameras.

Step 1:  Set the video camera to VTR or playback mode.

Step 2:  Navigate to the video clip to preview, using the DR-HD100 Left
and Right transport control buttons.

Play

Left Right
Transport Transport
(Back Index) (Forward Index)

Step 3:  Press the DR-HD100 Play button.

Step 4:  Search through the clips using the DR-HD100 Forward Search,
Forward Index, Backward Index, or Backward Search
buttons. Refer to “Navigation Buttons” on page 7 for more
information on the function of these buttons.

Camcorder Compatibility with External Players

Some HD camcorders are not compatible with the external player
functions Forward/Reverse Search and Pause.

VTR/CAMERA Button

On the JVC GY-HD100 camcorder, the VTR/Camera button is
located on the left side of the camera in the recessed LCD
compartment.

Search Modes and HD Recorder Mode

Slow-motion Forward Playback and all Reverse Playback search
modes are not available when in HD Recorder mode.
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DR-HD100:
Using with a Computer

Once video clips are recorded to the DR-HD100 it is possible to use
those clips in most computer based DV/HD NLE systems. This
section contains the following:

INitial SEIUP .ovviieeeee i 36
Mounting the DR-HD100 in WIiNndOws .........cccoccvvevieininnneen. 37
DR-HD100 and FAT 32.....coiiiiieeieeee e 39
Using Avid OMF Clips (Required for DV mode only) ........... 40
Dismounting the DR-HD100 (Windows).........cccvvveeeieeeeeennnn. 43
Mounting the DR-HD100 (Macintosh) ........ccccoocuvieiiiniinneen. 44
Dismounting the DR-HD100 (Macintosh) ........ccccccceeeeinnnee. 45

In the past, to get footage into an NLE system, it was necessary to
capture / digitize the footage using a video capture card. For most DV
and some HDV compatible NLE systems, DR-HD100 DTE
functionality eliminates the capture stage. All that is necessary is the
moving of the video files from the DR-HD100 to a computer.

Recording for Unsupported NLE

If a desired NLE is not supported by Focus Enhancements DTE, it is
necessary to use the AV/C control to capture the video footage for editing.
For more details refer to “Control Screen” on page 89.
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DR-HD100: Using with a Computer

To move video files from the DR-HD100 to a computer:

*  Connect the DR-HD100’s Computer /0 1394 port directly to
a computer with an active OHCI compliant IEEE-1394
FireWire port and the necessary FireWire disk drive drivers.

Ohote

For More Information

Go to the FOCUS Enhancements' website (www.focusinfo.com) for
more compatibility information.

* Usethe DR-HD100 HDD Bypass mode, refer below for more
information.

The DR-HD100 is compatible with any computer system that can
read FAT 32 volumes, such as Windows 98SE/ME/2000/XP and Mac
0S9/0S10.

Initial Setup

Step 1:  Enter HDD mode and enable DD Drive.
This step is required before mounting the DR-HD100 to a
computer.

* On the DR-HD100 go to the HDD screen.
* Select DD Drive and Right arrow to Connect screen.
» Press Enable function button.

Refer to the section, “HDD Mode Screen” on page 57

Step 2:  Connect the DR-HD100 through its COMPUTER I/O 1394 port
to the computer system using a standard 6-pin to 6-pin FireWire
cable.

Step 3:  Connect power to the drive if necessary.

Step 4:  Consult the computer’s documentation for more information.
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DR-HD100: Using with a Computer

Mounting the DR-HD100 in Windows
Use this procedure for Windows XP, 2000, 98SE and ME.

Step 1:  On a Windows-based computer system, double click the My
Computer icon on the top left hand corner of the desktop. A
directory window appears.

@ My Computer ;IEIEI
File Edit view Favorites Tools Help ‘
§=Eack - = - | @ search LY Folders @l X5 ‘ EE-

Address IE My Computer j @Go
Marne /- I Type I Total Size | Free Space |
EREAR L 1;  3velnch Floppy Disk

(=Local Disk {C:) Local Disk 5.85 GB 1.56GB

@Compact Disc {0:)  Compact Disc

(=Local Disk (E:) Local Disk 13.2 GB 10,4 GB

QCUmpact Disc {F:)  Compact Disc

SPPublic on Fs1' (3} Mebwork Drive 543 GB 50.9 GB

=PManuals on 'Fs1' (... Network Drive 548 GB 50.9GE

2Mpegs on 'Fs1' (M:)  Metwark Drive 543 GB 50.9GE

Control Panel System Folder

(SDR-HD100 (I Laocal Disk 37.2GE 37166

|10 object{s) |@ My Computer 4

Step 2:  Locate the DR-HD100 drive and open it.
Often, it appears as a standard FireWire disk drive and may be
labeled E:, F:, G:, and so on.

Step 3:  Open the DR-HD100 disk icon.
Step 4:  Open the folder with the most recent date code.

= E

Fle Edt Vew Favores Took Help

Qoo - © - @] P sercn foyrokes | 3 3 X 9| @

Address |« E:\ v Bco

Name ~ Sze Type Date Modfied
@0 Fie Folder 7/14/2005 3:53 PM
(=]} Fie Foider 7/14/2005 3:53 PM
@2 Fie Folder 7/14/2005 3:53 PM
a3 Fie Folder 7/14/2005 3:53 PM
24 Fie Folder 7/14/2005 3:53 PM
o5 Fie Foider 7/14/2005 3:53 PM
(=13 Fie Foider 7/14/2005 3:53 PM
a7 Fie Folder 7/14/2005 3:53 PM
(=) Fie Folder 7/14/2005 3:53 PM

Fie Folder 7/14/2005 3:53 PM

©220050803-164513-01 Fie Folder 8/9/2005 12:40 PM
Qg Fie Folder 8/3/2005 4:47 PM
) Desktop 0B 480KB Fle 7/14/2005 3:53 PM
(B Desktop DF 64KB Fie 7/14/2005 3:53 PM
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This folder may contain several different files. The video clips.
can appear as:

B¥ E:\20050803-164513-01
Fle Edt View Favortes Took Help (7]
Qe - @ - | Oseach fgrokdes | [ 3 X O [~
Address| & E:\20050803-164513-01 B
N 20050803-164654-01.dv \ 20050809-123952-01
DV Flle MOV Fie
24,141 KB 63,104 KB

N 20050809-124027-01
MOV Fie
38,800 KB

RawDV (.dv)

AVI Type 1 - (YYYYMMDDHHMMSSa01)

AVI Type 2 or AVI Type 2 24p - (YYYYMMDDHHMMSSb01)
Canopus AVI - (YYYYMMDD-HHMMSSbO01)

Matrox AVI - (YYYYMMDD-HHMMSSmO1
This file has a separate .wav audio file per track.

QuickTime or Quicktime 24p (.mov)

Pinnacle - (YYYYMMDD-HHMMSSp01
There are two separate .wav audio files per track.

Avid OMF (.omf)
OMF has two separate .aif audio files per track.

DR-HD100 Video Clips in Reel Folder

DR-HD100 permits the storing of video clips in either the
standard file folder or a Reel folder. If video clips have been
assigned to a Reel folder, it is necessary to run Organize
Reels before attaching the DR-HD100 to a computer.
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HD Resolution and Frames

» M2T filename format: YYYYMMDD-HHMMSSX01.m2t where
the X is a letter indicating the resolution of the captured video file.
The table below lists letters and associated resolutions. Not all
HDYV camcorders support these resolutions.

X Resolution X Resolution

d 720p, 23.976 fps D 1080i, 23.976 fps
b 720p, 24 fps B 1080i, 24 fps

¢ 720p, 25 fps C 1080i, 25 fps

a 720p, 29.97 fps A 1080i, 29.97 fps
e 720p, 30 fps E 1080i, 30 fps

f 720p, 50 fps F 1080i, 50 fps

g 720p, 59.94 fps G 1080i, 59.94 fps
h  720p, 60 fps H 1080i, 60 fps

y 576p, 50 fps

z 480p, 60 fps

DR-HD100 and FAT 32

The FAT32 file system limits file size to a maximum of 2GB which,
depending on record mode and resolution, approximately equals the
following minutes of video:

DV 9 minutes

720p 13 minutes

1080i 9 minutes

When clips exceed 2GB in size, the DR-HD100 automatically creates
a new, file without dropping any frames. The two files have the same
root filename but have different two digit suffixes that indicate the
order of their creation, -01, -02, and so on. This process can produce
as many sequential 2GB files as the drive can hold.

With most DV and many HDV compatible NLE systems on Windows
or Macintosh computers, it is possible to use clips within the timeline.
Select the clips on the source volume, i.e. the connected DR-HD100,
and import them directly into the NLE bin.

This makes clips immediately available in the NLE timeline.
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The high transfer speed of the DR-HD100 drive permits direct
streaming of the clips to the NLE, thus eliminating the need to copy
or transfer the clips before their use.

Using Avid OMF Clips (Required for DV mode only)

These steps are required when using Avid OMF formatted clips.

The Avid OMF file format was developed for use with Avid editing
products on Windows 2000, Windows XP or Mac 0SX. These
products include Avid Xpress Pro, NewsCutter, and Media Composer
Adrenaline (with the DV option).

The Avid OMF file format creates three files simultaneously; one
OMF video file and two separate AIF audio files. On the computer's
desktop, the files appear similar to those shown below.

O o

Fi= Edt Wew Favortes Toos  Hep L

| X9 "

On the DR-HD100, the video file (OMF) and the audio files (AIF)
appear as one track.

When an Avid OMF file is deleted, the DR-HD100 deletes the audio
and video portions at the same time.

40 ProHD DR-HD100 Portable DTE Recorder



DR-HD100: Using with a Computer

To use a DR-HD100 recorded Avid OMF file on an Avid NLE
system, use the following procedure.

ORGANIZE OMF Function

If using the ORGANIZE OMF function on the DR-HD100 before connecting
it to a computer, steps 2 and 3 are not necessary

Step 1:
Step 2:
Step 3:
Step 4:

Step 5:
Step 6:

Step 7:
Step 8:

x
Uedm Orien(s) Proctas
ca +
TWEWPCIHD:)
A +
* - * »

Locate and open the DR-HD100 drive folder.
Create a new folder and name it OMFI MediaFiles.
To do this in Windows, select File>New>Folder .

To do this with Macintosh, select File>New Folder. Next,
type OMFI MediaFiles.

Drag all the OMF and AIF files into the new folder:
Do Not Drag in the files titled Desktop DB or Desktop
DF.

Launch Avid.
Open an existing project or create a new one.

Select Tools>MediaTool. A screen similar to the
following appears:

Carrne! Bzpel A1 Projects
il e i

= @ venr (s
o | Precerees (308
Bl _ vessFies

]
;
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Step 9: Locate and select the DR-HD100 under Media Drive(s).

If Drive Does Not Appear

If the drive does not appear, check to make sure that the
OMFI MediaFiles folder was created correctly with proper
case and spacing.In addition, verify that the drive is properly
connected and recognized by the computer. Under
Project(s), select All Projects (This highlights all items in
the Project(s) window).

Step 10:  Verify that Master Clips is checked and press OK. The
Media Tools Window, similar to the following, appears:

NP

e (e bR Egl

e Tracks ;r' Erd Cospimn ar|
4 4 1B 1 '] hE #
B Xeiaisaian wviaid naisaw  nadaagt nu

T INEM-1ITE WAl-D F424EE ZA14TRH Lol &L

H
| T — *
T A AN N S==SbLL.LVbEER

Step 11:  Create a new bin (select File -> New Bin) or open an
existing bin in Avid.

Step 12:  Select all items in the Media Tools window (select Edit>
Select All).

Step 13:  Drag the contents of the Media Tools Window into the bin.
It is now possible to use these clips in the Avid timeline.
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Dismounting the DR-HD100 (Windows)

When finished working with the DR-HD100 and the computer, it is
necessary to dismount DR-HD100 from the system

A Dismount DR-HD100 Before Powering Off

It is important to dismount the DR-HD100 from the Windows
system BEFORE powering down the unit.
To do dismount the DR-HD100:

Step 1:  Click the Safely Remove Hardware icon at the bottom right side
of the Windows task bar as shown below.

§%  12:13PM

Unplug or Eject Hardware Icon J

(Safely Remove Hardware)

Step 2:  Next, the computer system prompts to remove the connected
DR-HD100. This begins the dismount process.

Step 3:  Select the message and click on it.

The computer dismounts the DR-HD100 and then displays a
message that it is now safe to remove the unit.
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Mounting the DR-HD100 (Macintosh)

Step 1:

Step 2:
Step 3:

44

Start the Mac computer and connect the DR-HD100’s
COMPUTER I/0 port to the computer using a standard 6-pin to
6-pin FireWire cable.

When mounted, the DR-HD100 should appear on the computer's
desktop as shown below:

M = ) Fri8:56AM |

F5083004

The DR-HD100 appears as a FAT32 volume with a PC label.
Locate the DR-HD100 on the desktop and open it up.

Open the folder with the most recent date code (for example,
“20050127-110345-017). It should look similar to the
following:

@_ 20030831-072917-01.mov
@_ 20030831-073322-01.mov
@_ 20030831-073457-01.mov
@_ 20030831-073505-01.mov
@_ 20030831-073508-01.mov
@_ 20030831-073514-01.mov

g Macintosh HD
Ll Fsos3004 =

u Desktop

ﬁ mattmcewen

A Applications

ﬁ Documents

ﬁ Movies
& Music

gfu Pictures

6 items, 35.75 GB available

Before Connecting DR-HD100 to a Computer
If clips have been assigned to a Reel folder: perform an Organize
Reels before connecting the unit to a computer.
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Dismounting the DR-HD100 (Macintosh)

When finished working with the DR-HD100 and the Macintosh it is
necessary to dismount the unit from the system.

A Dismount DR-HD100 Before Powering Off

It is important to dismount the DR-HD100 from the Mac system
BEFORE powering down the DR-HD100.

To dismount the DR-HD100 from a Mac:

Step 1:  Select the DR-HD100 on the computer's desktop. It is marked
with a PC symbol.

Step 2:  Drag the drive into the trash or use the eject button. This
dismounts the particular disk drive.

Step 3: It is now safe to remove the DR-HD100.

ProHD DR-HD100 Portable DTE Recorder
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Mounting Hardware

Mounting DR-HD100 to a Camcorder

Mount the DR-HD100 to your camcorder using the optional
Camcorder Mount Kit (P/N ASYF-0849-01). For more information
about this kit or to order it, contact Focus Enhancements:

Telephone: 408-866-8300

Address: Focus Enhancements, Inc.
1370 Dell Avenue
Campbell, CA. 95008
www.focusinfo.com

Clipping to a Belt

Belt Mount Clip
Front View Side View

DR-HD100
Belt Clip Post

A belt mount clip is included with the DR-HD100. This mount is
similar to those used with cellular telephones. Attach the belt mount
to the belt clip post on the rear of the DR-HD100 and push it down to
lock it in position. The belt clip can ratchet to various positions when
attached to a belt.
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This section contains information on the following LCD displays:

General Screen Information .........ccccccvveeieiiiiiiiccceee 48
Record SCreens ..o 52
HDD MoOdE SCreen ......ccooooeiiiiieiieeeee e 57
Format SCreen ... 60
HD Format SCreen ........cccccvviiiiiiiiiieee e 61
SEtUP SCrEENS ... 62
FUNCLIONS SCreen ........ovvviiiiiiiiiee e 70
ULilities SCreen .....ooovveeeecccce e 74
CoNtrol SCrEEN .....vvveiiiiiiee e 89

DR-HD100 screens are organized in a flat hierarchy. Every screen has
a unique name, and it is possible to cycle continuously through the
screens using the Left and Right navigation buttons.

Use the Up and Down navigation buttons to cycle through screen
items (selections).

Use the Select Navigation button to make a choice.

Navigation Tip: Jump to Top of Display Using the Left Button

When navigating through the LCD displays and scrolling down into the
menu, press the Left navigation button on the front panel and immediately
return to the top of the display, which allows navigating to other displays.
Jump to Home display Using Select Button

To return immediately to the Home Screen, navigate to the menu title at the
top of the screen and press the Select button.
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General Screen Information

The DR-HD100 LCD displays are organized by function with each
screen displaying a list of items. An item can be:

A value that can be set, such as the date.

A switch similar to a check box, that can be enabled along
with other options in the display.

A switch similar to a radio button, that belongs to a family of
options, in which only one can be active at any time.

A link to another display, which is indicated by a .

SETUP Menu Title
Appears at the top of the
01/16/ 06 display and identifies its

topic or function.

09:30:19

V1.0.0
-LCDLIGHT ON

Navigation

Use the Left or Right Use the Up and Down
navigation buttons to move navigation buttons to move
to the previous or next between the items in the
display. display.

Welcome Screen

The Welcome screen appears briefly after boot-up, and automatically
switches to the Home screen when the DR-HD100 is ready for
operation.

48

FIRESTORE
DR-HD100
PORTABLE

DTE RECORDER
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Home Screen

The Home screen is read only and has no navigable items. To leave
the Home screen use either the Left or Right Navigation button.

1 2

. STOP 1- 47-3
12 —»oooo1402 !5
| DISK1 168 min <-—6

10——»= REEL
I SY¢NC DI{P LO¢CK
7 8 9

1. Current Function: Symbol and Description
Refer to “LCD Display Symbols and Text” on page 91.

2. Volume Disk Number
The volume number is always 1 unless multiple DR-HD100’s
are connected, refer to “USE EXT DR-HD” on page 58.

3. Clip Number

Number of the current video clip, i.e. 001 for clip 1.
The system can hold a maximum number of 999 clips.

4. Battery Life Gauge

This gauge is accurate only when the unit is powered
exclusively from the battery.

5. Timecode Value

Either Drop Frame - 00;00;00;00 or, Non Drop Frame -
00:00:00:00.

6. Time remaining on the disk.

7. FA Functions with SYNC as the default, refer to “Functions
Screen” on page 70 for more information.

8. FB Functions with DISP as the default, refer to “Functions
Screen” on page 70 for more information.

9. FC Functions with LOCK as the default, refer to “Functions
Screen” on page 70 for more information.
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50

10. Reel Display

In Record or Playback modes, this item displays the particular
REEL that a clip is located in or, has been marked to. If in
PLAY FROM > REEL LIST mode, the REEL appears in
brackets for example, [REEL]. This area is blank if NO REEL
has been selected.

11. DISP information field that displays data type.

12. DISP information field that displays current data.

DISP (display) Information Fields

Use the DISP function button to display current operation
information fields 11 and 12. The data shown depends on the
mode of operation, i.e. DV or HD Recorder.

Pressing the DISP button advances the display to the next
category of information. Below is a table of the data types and
data available with DISP.

Field
Number

11
12

1

12

1
12

1
12

Data Type /
Data Description

COUNTER

Shows frame count of current video clip during record or
playback.

REMAINING

Record: counts down number of available frames
remaining, as time, on a specific disk.
Playback: displays time remaining of the current clip.

DV (NTSC or PAL) or HD (see note following table)

Record: displays the external timecode value being
generated by a camcorder or other device during a
recording session. Timecode mode must be set to EXT
TC for this function to operate, refer to “TIME CODE
EXT, REC RUN, FREE RUN, REGEN" on page 66.
Playback: displays the embedded DV timecode value in
a particular track.

UB NTSC

Displays the set user bit value in a particular clip. A user
bit value must be added for this to display, refer to “UB
SET” on page 68.
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1 ABSOLUTE

12 Displays an absolute timecode value for the particular
session: the sum of all COUNTER timecodes on
connected volumes.

Absolute is primarily used when setting the DR-HD100
to AV/C mode and controlling it with an external FireWire
device, such as a computer.

DV (NTSC or PAL) and HD
The information displayed in fields 11 and 12 depends, in part, on which
Recorder Mode is set.
DV RECORDER
Line 11 displays the Standard Definition (SD) video format. It can not be
changed.
HD RECORDER
Line 11 displays the HD resolution of the current track which depends on
the camcorder in use with the DR-HD100 HD unit. Possible values are:
+ 1080/50i TC
+ 1080/60i TC
« 720/30p TC
e 720/25p TC
« 720/24p TC
+ 576/50p TC

« 480/60p TC
Refer to the camcorder manual for supported resolutions.

DR-HD100 System Information Screens

The DR-HD100 automatically creates information screens to indicate

conditions such as high temperature, power remaining, or drive
capacity remaining.

WARNING

5%

POWER
REMAINING
OK

Press OK to clear the screen and return to the last screen.

ProHD DR-HD100 Portable DTE Recorder
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Record Screens

NORMAL
-RETRO DISK

RETRO CACHE
LOOP RECORD

The Record screen permits setting the DR-HD100 to various
recording modes, depending on the model:

* NORMAL

* RETRO DISK

* RETRO CACHE

*+ LOOP RECORD

e SNAP DV modes only

¢ TIME LAPSE DV modes only

Once a record mode is selected, the recorder remains in that mode
until a different mode is chosen. Exiting the Record screen and
returning to Home, enables the selected recording mode.

To verify that the digital recorder is set to the correct recording mode,
refer to the upper left-hand of the Home screen where the recorder
mode is displayed.

Record Mode Indicator
(Retro Cache)

Symbol Indicates

L Retro Disk
Cc Retro Cache
(0] Loop Record
SNAP Snap Record
T Time Lapse
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For more about LCD display symbols and text, see “LCD Display
Symbols and Text” on page 91.

Normal Record

This is the standard recording mode.
* All control is from the DR-HD100 front panel.
Initially, the Home screen displays m STOP.

*  Pressing Record @ puts the DR-HD100 into Il REC PAUSE
mode.

* Pressing Record @ a second time puts the DR-HD100 into
REC mode.

Retro Cache Record Mode

:00
:SS <«———This line is not active:
reference only.

The Retro Cache mode insures that important material at the very
start of a recording session is captured. Retro Cache stores in the on
board memory a continuous loop of video captured by video camera
during pauses. Pressing Record ® begins active recording at the last
frame stored in the cache. The resulting video clip has the cached
video at the beginning.

Retro Cache is available in Local, JVC GY-HD, Syncro Slave, and
External control modes.

Set the length of video that the Retro Cache should store: 0 to 10
seconds.
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Retro Disk Record Mode

HDD AVAIL.:
176 min

RETRO TIME:

010 min -a———.This is the only
editable line on screen.

The Retro Disk mode records video in a continuous loop to a user-
defined portion of disk space. Pressing Record ® seamlessly begins
active recording. The Retro Disk session is appended to the beginning
of the new clip. The result is a set of clips beginning with the cached
video and continuing with the newly recorded video.

54

When calculating the amount of hard disk space needed for a

Retro Disk record session, always include additional space

beyond the recording requirements. The added space depends

on the length of the loop.

*  Loops less than 60 minutes, need an additional 1 minute of
unused disk space.

*  Loops 60 minutes and greater, require an additional 2GB of
unused disk space.

When looping less than one hour, Retro Disk records the

loop in a series of 1 minute clips.

Retro Disk is available in Local, JVC GY-HD, Syncro Slave and
External control modes.

When Retro Disk is set, the symbols eL (Record and L)
appear in the DR-HD100 display.
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Loop Record
Loop Record is similar to Retro Disk.

Loop Record continuously records a series of video clips to available
disk space. When all available disk space is used, Loop Record
begins sequentially replacing the earliest clip with the most recent.

»  The size of the video clip depends on the length of the loop.
e Loops of 60 minutes or less are recorded in one-minute clips.
*  Loops greater than 60 minutes, are recorded in 2GB clips.

*  When the capacity of the disk is reached, one additional clip is
created. The size of the last clip depends on the length of the
loop i.e., one-minute or 2GB. The disk must have at least 30
minutes of disk space available for this functionality.

Saving Loop Record Clips
Press STOP during a record session.

The DR-HD100 stops recording and saves the current LOOP RECORD
session clips to a folder on the disk.

Snap Record DV modes only

Use Snap to record individual frames. In Snap mode, pressing
Record @ captures individual frames. All the frames recorded in the
same session are stored in a single file.

» To start a new SNAP record session, place the unit in STOP
between SNAP records.

*  Snap Record is available only in DV modes of operation.

* Use Snap in Local, JVC GY-HD, Syncro Slave, and External
control modes.

* Removing power from the DR-HD100 in the midst of a Snap
recording session causes the unit to return to Normal
recording mode when it powers back up.

Ohote

Another Method to Capture Single Frames
An alternative to Snap is EXT CTL FRAME. For more information see
“EXT CTL OFF, Pause, Frame, File” on page 65.
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Time Lapse Record DV modes only

00:00:00:00

HH:MM:SS:FF <—5——This line is not active:
reference only.

Time lapse provides the ability to record a single frame at specific
time intervals, for example one frame per minute, 00:01:00:00. Time
lapse applications can include capturing the traffic on city streets, the
growth of a plant from seed to maturity, and construction projects.

Features of the Time Lapse function include:
*  All the captured frames are recorded in a single clip.

* The time between recording periods can be set in frames,
seconds, minutes, and hours.

¢ The maximum time between recorded frames is 24 hours.
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HDD Mode Screen

-DV RECORDER
HD RECORDER

DD DRIVE
USE EXT DR-HD

This screen displays the following items:
DV RECORDER
This sets the DR-HD100 as a DV recorder.

Connect the camera to the DR-HD100 DV 1/O port using a
FireWire cable.

« HD RECORDER
This sets the DR-HD100 as an HD recorder.

Connect the camera to the DR-HD100 DV 1/O port using a
FireWire cable.

Recording in this mode only works with HDV camcorders
that have a 1394 FireWire connector and that support an HD
resolution, such as 1080i or 720p.

Switching Between Recorder Modes (DV and HD)

Switching between recorder modes resets the RECORDER mode to
Normal, see “Normal Record” on page 53.

Power-cycle After Changing Recorder Modes

It is recommended that the DH-HD100 be power-cycled after switching
RECORDER modes.

« DDDRIVE p

Use this option when connecting the DR-HD100 to a
computer. The DR-HD100 functions as a volume visible to
the computer. In addition, this setting permits the connecting
of multiple DR-HD100s together to increase recording space.
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* USE EXT DR-HD

Use this option when longer recording times are needed. USE
EXT DR-HD permits the connecting of two DR-HD100
together to provide more disk storage for longer recording.
One unit acts as the master with the other as a slave: the
master records to itself until full and then continues recording
on the slave unit.

Identifying Master/Slave Volumes During Record/Playback

When two DR-HD100s are in combined via USE EXT DR-HD and in
either Record or Playback mode, the volume on the Home screen will
display 1-xxx when the master unit is recording or playing back and 2-
xx if it is the slave.
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Setting Up Master and Slave DR-HD100

DTE recrmoLosy

Step 1:

Step 2:

Step 3:

Step 4:

Step 5:

COUNTER
00:00:00:00
DISK 1 000min

Master DR-HD100 Slave DR-HD100

DTE rechnoLocy
STOP 1 -001
COMPUTER THEN
ENABLE BYPASS

SUCCESS

SYNC DISP LOCK EXIT

Connect the camcorder to the master DR-HD, DV I/O connector
using the supplied FireWire cable.

Master

Power on unit.

Go to the HDD Mode menu screen and enable
USE EXT DR-HD.

Connect the DR-HD100s through the units Computer I/O
connectors using a 6-pin to 6-pin FireWire cable.

Slave
Power on the unit
Go to the HDD Mode screen and enable DD DRIVE.

Master
Begin recording or playback using the master DR-HD100.

A Use DD Drive Mode when Connecting to a PC

It is important to take the master DR-HD100 out of USE EXT
DR-HD mode before attempting to connect to a computer.
To do this, select DD DRIVE from the HDD Mode screen.
This returns use of the unit to hard disk mode.
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Format Screen

DV Formats

AVI TYPE 1

AVI TYPE 2
CANOPUS AVI

DV formats include:

+ RAWDV
« AVITYPE 1

« AVITYPE 2

+ CANOPUS AVI

«  MATROX AVI

«  QUICKTIME

« AVID OMF

«  QUICKTIME 24P (NTSC only)
«  AVITYPE 2 24P (NTSC only)
+  PINNACLE

Using Organize PINN and Organize OMF

AVID OMF and PINNACLE formats require using the Utilities functions,
Organize PINN or Organize OMF respectively. Refer to the section, “Utilities
Screen” on page 74.

Formats for 25P Applications
Use standard file formats for all 25P applications except AVID OMF. OMF is
not compatible with 25P DV streams.

The latest DTE supported applications and file formats are listed on
the Focus Enhancements website: www.focusinfo.com.
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HD Format Screen

The latest DTE supported applications and file formats are listed on
the Focus Enhancements website: www.focusinfo.com.

Check regularly for updates.
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Setup Screens

10/10/05
21:10: 50

vV 1.0.0
-LCDLIGHT ON

The items on the Setup Screen are grouped by function. Within the
function the items act like radio buttons, i.e. when one is active the
others are not.

In some cases, such as the Date, a settings screen appears. To return
from a settings screen, use the BACK function button.

The items displayed on the Setup screen include:

62

DATE Displayed p
TIME Displayed P>
VERSION Displayed P>

LCDLIGHT ON Group Default
LCDLIGHT OFF
LCDLIGHT AUTO

ALARM ON Group Default
ALARM OFF

STOP FRAME; (1st frame of current clip) Group Default
STOP GRAY
STOP NO VIDEO

EXT CTL OFF Group Default
EXT CTL PAUSE

EXT CTL FRAME

EXT CTL FILE

TC EXT Group Default
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¢ TC REC RUN DV mode only
¢ TC FREE RUN DV mode only
¢ TC REGEN DV mode only

+ TCSET p
+ UBSET p

¢ TC DROP NTSC only
¢ TC NON-DROP Default, NTSC only

e LCD CONTRAST
Olote

Date and Time Must Be Set
The date and time must be set. They are used in the DR-HD100 file naming
function. Refer to “Set Time and Date” on page 25.

Date
SET DATE
09/18/ 05
MM /DD /YY
BACK
Time

SET TIME
10 : 50 : 40

HH: MM : SS

BACK
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Version

1.0.0.01010106
NTSC
DR-HD100

BACK

This screen displays:

DR-HD100 Firmware version
SD video of the unit.
DR-HD100 model

LCD Light On, Off, Auto
These items enable or disable the DR-HD100's LCD's backlight.

LCDLIGHT ON Group Default

keeps the backlight on permanently.
LCDLIGHT OFF

Keeps the backlight off permanently.
LCDLIGHT AUTO

Turns off the backlight after one minute, pressing any button
pad button turns the backlight back on.

Any information screen turns the backlight on.

Alarm On, Off

Default is On.

64

When the alarm is enabled, pressing any button on the DR-
HD100 produces audio feedback.

The DR-HD100 alarm triggers when conditions such as low
battery charge, low disk space, or over heating occur.
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When Alarm is set to Off, the audio feedback for the buttons
is disabled, however the alarm will still sound for low power,
high heat, or low disk space conditions.

Stop Frame, Gray, No video

These settings determine the DR-HD100 video output when it is in
STOP mode.

STOP FRAME Group Default (DV only)
Displays the first frame of the clip.
STOP GRAY (DV only)

Displays a black frame.

STOP NO VIDEO

Video output is Off.

EXT CTL OFF, Pause, Frame, File

These options permit the use of an external device to control the DR-
HD100 through the optional RS-232 cable.

Ohote

RS-232 Cable Available from Focus Online Store

The RS-232 cable required to connect the DR-HD100 to an external control
device is Focus part number CBLA-0113-01. It and other accessories
mentioned in this manual are available at https://www.focusinfo.com/sales/
store.

EXT CTL OFF
Use this option when connecting an external device using an
RS232C cable.

e This requires the use of a a 3.5mm-to-DB9 adapter cable,
plugged into DR-HD100 Control port.

In Local mode, select this item to control the DR-HD100
with the optional wired remote control unit.

The following options permit control functions to occur from a
simple contact closure.

EXT CTL PAUSE

Controls Pause and Resume during a record or playback
session.

EXT CTL FRAME DV Mode Only

Captures a single frame of video and records it to a file. Each
time this function is triggered, it sequentially adds another
frame to the same file until stopped.
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EXT CTL FILE
Creates a new file during a record session without losing
frames.

TIME CODE EXT, REC RUN, FREE RUN, REGEN

The following are timecode (TC) functions.

66

Ohote

TC EXT Group Default

Records the incoming source timecode. If the timecode is not
running, the DR-HD100 records the same timecode number
in each recorded frame. Choose TC EXT mode to clear any
stored number.

TC REC RUN DV mode only

In this mode, after a power cycle, the DR-HD100 starts its TC
record count using the TC SET value. Later recordings add to the

last value recorded. A power cycle resets the TC record value to the
TC SET value.

TC FREE RUN DV mode only
This function causes the DR-HD100 to begin counting from
the value stored by TC SET.

* A number entered through TC SET is not stored and available
to the DR-HD100 until exiting TC SET. Only then does the
DR-HD100 begin counting using that number.

TC REGEN DV mode only

When the DR-HD100 powers up in TC REGEN mode, it:

*  Reads the timecode of the last track recorded.

* Adds 1 to the number.

*  Stores the new timecode as the number that will be assigned to
the first frame of the next recording session.

If the drive is empty, i.e. no existing recordings with , the

DR-HD100 uses the TC SET value.

TC SET and UB SET Can Be Set at the Same Time
Both parameters, TC SET and UB SET, may be set and are not mutually
exclusive as in some groups, i.e. LCDLIGHT.
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TC SET

TC SET

00 :00:00:00
HH: MM : SS:FF

The Timecode Set parameter stores a user defined timecode in the
DR-HD100’s non-volatile memory. This value is available for use by
the DR-HD100 immediately after exiting TC SET.
¢ TC FREE RUN
The DR-HD100 uses this value on the next recording after it
is set in TC SET.
* TC REGEN
This is the starting value when using an empty hard disk
drive for recording.
* TCRECRUN

This is the value used to begin every recording session after a
power cycle.

The TC SET value is only actively applied when the unit is in
DV RECORDER mode.
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UB SET

UB SET
FF : FF : FF : FF

The User Bit Set function provides the ability to change the user bits
in the timecode recorded in the video files.

*  Timecode values are not set when in TC EXT mode.

Professional applications employ user bits to add metadata to
recordings to assist in post production. For example, multiple
cameras are used during a shoot. Each DR-HD100 has a unique UB
setting that identifies it and the camera it serves. Later, the user bits
are used to determine from which camera station the footage was
recorded.

The UB SET value is only actively applied when the unit is in
DV RECORDER mode.
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TC DROP, NON-DROP NTSC only

These parameters are only available for NTSC and only one may be
enabled at a time. Drop and non-drop enable and disable the drop-
frame function that modifies how the timecode is calculated during
recording. These options are only applied when the unit is in DV
RECORDER mode.

« TCDROP

Enables the drop-frame function:

e Frames 00 and 01 are dropped from each minute of video
recorded.

e Exception The first minute of each hour is not dropped.

¢ TC NON-DROP Group Default
Disables drop-frame. No frames are dropped during
recording and the timecode reflects the actual time during
recording.

Use with TC FREE RUN or TC REGEN
TC DROP and TC NON-DROP may only be set when using the TC FREE
RUN or TC REGEN settings.

LCD CONTRAST

SET CONTRAST
VALUE: 00

Use this function to adjust the contrast of the LCD display for easier
viewing.

Step 1:  Use the Right navigation button to go to the SET CONTRAST
submenu.

Step 2:  Use the Up and Down navigation buttons to increase and
decrease the contrast number.

Step 3:  Press BACK when done.
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Functions Screen

The Functions buttons FA, FB, and FC provide convenient Home
screen shortcuts by acting as toggle switches for specific system
settings. The Home screen below is an example of the information
displayed.

= STOP 1-

COUNTER K |
00:00:20:15
DISK 1 168 min

Reel receiving — == R1
clips.

Function Keys

FA FB FC
Function Groups

Function settings are user-assignable and available in the Functions
screen. Changing a setting with a Function button has the same effect
as manually changing the setting.

FUNCTIONS

-FA JVC GY-HD
FA SYNC

FAAV/C
FA EXTERNAL

*  There are three groups of functions FA, FB, and FC displayed
via the Functions screen.

*  The function groups are independent of each other.

* In each group only one selection is active at a time.
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Functions List

A list of the Function button menu is below. In each group, the default
selection is listed first.

MENU Appears on LCD as...
FA JVC GY-HD JvC
Toggles between JVC GY-HD and LOCAL control modes.
FA SYNC SYNC
Toggles between SYNCRO and LOCAL record control. Default
FA Av/C AV/C (Toggles between AV/C and LOCAL control)
FA External EXTL (Toggles between External TRIGGER and LOCAL control)
FA REELS REEL Increments current reel number
FA RO-0 RO Marks Current Clip to Reel 0,
FA R1-1 R1 Marks Current Clip to Reel 1,
FA R2-2 R2 Marks Current Clip to Reel 2,
FA R3-3 R3 Marks Current Clip to Reel 3,
FA R4-4 R4 Marks Current Clip to Reel 4,
FA R5-5 R5 Marks Current Clip to Reel 5,
FA R6-6 R6 Marks Current Clip to Reel 6,
FA R7-7 R7 Marks Current Clip to Reel 7,
FA R8-8 R8 Marks Current Clip to Reel 8,
FA R9-9 R9 Marks Current Clip to Reel 9,
FA LCD ON/OFF LCD1/LCDO LCD On/Off Toggle
FA LCD AUTO LCDA/LCDO LCD Auto On/Off Toggle
FA BLANK No Function.
FB DISP DISP (Toggles the different TC display modes) (Default)
FB ALARM ALRM/MUTE Turns the DR-HD100 alarm on or off.
FB FILE FILE (Toggles between normal and display of the file name)
FB REELS REEL Increments current reel number
FB RO0-0 RO Marks Current Clip to Reel 0,
FB R1-1 R1 Marks Current Clip to Reel 1,
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MENU Appears on LCD as...
FB R2-2 R2 Marks Current Clip to Reel 2,
FB R3-3 R3 Marks Current Clip to Reel 3,
FB R4-4 R4 Marks Current Clip to Reel 4,
FB R5-5 R5 Marks Current Clip to Reel 5,
FB R6-6 R6 Marks Current Clip to Reel 6,
FB R7-7 R7 Marks Current Clip to Reel 7,
FB R8-8 R8 Marks Current Clip to Reel 8,
FB R9-9 R9 Marks Current Clip to Reel 9,
FB BLANK No Function.
FC LOCK LOCK/UNLK Locks the buttonpad (Default) - toggles between
LOCK and UNLK <Unlock>
FC DV/DD DD Toggles DR-HD100 between DV/HD and HDD Modes
FC REELS REEL Increments current reel number
FC R0-0 RO Marks Current Clip to Reel 0,
FC R1-1 R1 Marks Current Clip to Reel 1,
FC R2-2 R2 Marks Current Clip to Reel 2,
FCR3-3 R3 Marks Current Clip to Reel 3,
FC R4-4 R4 Marks Current Clip to Reel 4,
FC R5-5 R5 Marks Current Clip to Reel 5,
FC R6-6 R6 Marks Current Clip to Reel 6,
FC R7-7 R7 Marks Current Clip to Reel 7,
FC R8-8 R8 Marks Current Clip to Reel 8,
FC R9-9 R9 Marks Current Clip to Reel 9,
FC BLANK No Function.
72 ProHD DR-HD100 Portable DTE Recorder




DR-HD100 Functions

Assigning Clips to Reels

CIm
168 min

COUNTER
00:00:20:15
DISK 1

Currently
| REEL
Selected \i R1
M REEL __R2 R
Function FA /_ T
set to FA REELS
Function FB Function FC
set to FB R2-2 set to FC R1-1

The function buttons are a quick way to mark video clips during
recording. The Functions menu offers two types of markers to
use, as an example FA REELS and FB R2-2.
» FAREELS

Selecting the FA REELSs programs the DR-HD100 to mark

the clips to the currently selected reel. The current reel is
indicated in the line above the FA function reel selection.

* FBR2-2

Setting a function button to this type of marker, instructs the
DR-HD100 to mark the current clip as belonging to the
REEL R2.

Blank

Functions identified as Blank are inactive.
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Utilities Screen

UTILITIES

ORGANIZE REEL
ORGANIZE OMF

ORGANIZE PINN
DELETE CLIP

The Utilities available are:
« ORGANIZE REEL
* ORGANIZE OMF
* ORGANIZE PINN

e DELETECLIP p

¢ FORMAT p

¢ REPAIRDISK p

¢ REPAIRCLIP p DV mode only
« FILE NAME p

¢ UPGRADE p

e SYSTEMRESET )p

« DIAGNOSTIC p

¢ STATUS p
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Organize Reel

This selection places all files identified as a REEL clip during
recording or playback into the appropriate reel folder. You can import
this folder directly into most DV NLE bins.

Organize OMF

When files are recorded in the AVID OMEF file format, this selection
allows you to take all the OMF and AIF audio files at the end of a
recording session and place them into a folder on the disk drive
named OMFI MediaFiles. When the disk is connected to a computer,
this folder is recognized by Avid Xpress DV's Media Tool enabling
direct import of files into the Avid timeline. Refer to the section,
“Using Avid OMF Clips (Required for DV mode only)” on page 40
for more information.

Organize PINN

This selection organizes clips for use with Pinnacle Liquid series
NLE systems. Products such as the Pinnacle file format were created
for use with products such as Pinnacle Liquid Edition. The Pinnacle
file format creates three files simultaneously during a recording; an
AVI video file and two separate WAV audio files labeled as left and
right. An additional ALE file for each recording session is also
created which contains timecode data. This file must be kept with the
media.

Once clips have been imported into Liquid Edition, an Index file is
created on the disk drive for each clip. Do not delete this file since it
is required to continue work in the particular project.
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Delete Clip

DELETE CLIP
CLIP 001

YES BACK

Use this item to delete a selected clip.

Step 1:  From the Utilities screen, go to the DELETE CLIP screen.

Step 2:  Enter the number of'the clip to be deleted using the Up and Down
navigation buttons.

Step 3:  Press the YES function key.
The selected clip is deleted.
Step 4: Press BACK to return to the Utilities screen.

When a clip is deleted, the DR-HD100 re-organizes and displays the
remaining clips in sequence. For instance, if there are three clips on
the disk: 1-001, 1-002, 1-003. If clip 1-002 is deleted, the remaining
clips are reorganized and clip 1-003 becomes clip 1-002. However the
base file names are not affected.

Use Delete Clip Sparingly
Using the delete clip can cause disk fragmentation that reduces disk drive
performance and can impact both Playback and Record. To defragment the
disk or if more disk space is needed:

Transfer all content from the DR-HD100.

Perform the FORMAT utility, see “Format Disk” on page 77.
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Format Disk

FORMAT DISK

PRESS YES TO
ERASE ALL DATA

YES BACK

Prevent lost frames due to file fragmentation by formatting the
DR-HD100 before each recording session.

A Save Files Before Formatting

The formatting process erases all data on the disk and is not
reversible. Backup all files and clips on the DR-HD100 before
formatting.

This selection formats the disk as follows:

Step 1:  From the Utilities screen, go to Format Disk.

Step 2:  Select YES to begin formatting.
A status screen displays progress of the formatting and at
completion displays the message:

» Complete indicating Repair Disk was successful.

» Aborted indicating that there were errors and the repair did not
complete.

Step 3:  Press BACK to return to the Utilities screen.
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Repair Disk

REPAIR DISK

PRESS YES TO
REPAIR DISK

YES BACK

Use this function if a recording session does not complete properly
and there is a question that the file may be damaged. For example,
recording terminates due to a loss of power to the DR-HD100. Repair
Disk scans the entire disk drive checking for and repairing file errors
and incomplete files. When the file is repaired it is can be used in the
NLE system.

Corrupted Files May Need More Repairs
After running Repair Disk some files may still need further work to restore
them. In such a case, run the utility Repair Clip, refer to the following page.

To repair a disk:

Step 1:  From the Utilities screen, go to Repair Disk.

Step 2:  Select YES and the DR-HD100 begins repairing the disk.
A status screen displays the progress of disk repair and at
completion displays the message:

+ Complete indicating Repair Disk was successful.

» Aborted indicating that there were errors and the repair did not
complete.

Step 3:  Press BACK to return to the Utilities screen.
Step 4: Move content from DR-HD100.

Step 5:  Use Format Disk utility before doing any further recording. This
step optimizes disk storage, see “Format Disk” on page 77.
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Repair Clip DV Mode only

REPAIR CLIP

CLIP 001

YES BACK

Use this function to repair a specific file that may be damaged or
incomplete. For example, recording terminates due to a loss of power
to the DR-HD100 and a specific file may be damaged. Repair Clip
scans the specified file checking for and repairing file errors and
incomplete files. When the file is repaired it then can be used in the

NLE system.
Step 1:  From the Utilities screen, go to Repair Clip.
Step 2:  Enter the number of the clip to be repaired, using the Up and
Down navigation buttons.
Step 3:  Press YES and the DR-HD100 begins repairing the file.
A status screen displays the progress of disk repair and at
completion displays the message:
» Complete indicating Repair Disk was successful.
» Aborted indicating that there were errors and the repair did not
complete.
Step 4: Press BACK to return to the Utilities screen.
Step 5:  Move content from the DR-HD100.
Step 6:  Use Format Disk utility before doing any further recording. This

step optimizes disk storage, see “Format Disk” on page 77.
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File Name

FILE NAME
CLIP 001

20060101 -
165423

This function displays a file name but does not permit changing it.

Step 1:  From the Utilities screen, go to FILE NAME.

Step 2:  Enter the file’s clip number using the Up and Down navigation
buttons.

The base filename is dynamically displayed as a function of the
clip number.

When a clip has multiple files, the first Base file name is
displayed

Step 3:  Press BACK to return to the Utilities screen.
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Upgrade

Check Focus Enhancements website for upgrades and latest software
updates, go to www.focusinfo.com.

To upgrade system software:

Step 1:  Set the DR-HD100 to DD Drive mode from the HDD Mode
screen and connect it to a computer.

Step 2:  On your computer, rename the XXX.bin file as dr-hd.bin.

Step 3:  Copy or drag the dr-hd.bin file to the DR-HD100 while it is in
DD Drive mode.

Step 4:  Exit the DR-HD100 from DD Drive mode and navigate to the
Utilities screen.

Step 5:  From the Utilities screen, go to Upgrade.
Step 6:  Press Right. The following screen appears.

UPGRADE

PRESS SELECT
TO UPGRADE

SOFTWARE
BACK

Step 7:  Press Select.

Step 8: A confirmation screen appears: press YES to continue.
A status screen displays the progress of the upgrade.

UPGRADE
UPGRADING ...
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Step 9:  Up on successful completion of the upgrade, the DR-HD100
displays the message:

UPGRADE
COMPLETE

PLEASE RESTART

Step 10: Hold down the STOP / POWER OFF button until the DR-HD100
shuts down.

Step 11: Power up the DR-HD100.

Upgrade Errors

If the upgrade fails, the DR-HD100 displays one of the following
messages:

UPGRADE ERROR

WRONG PRODUCT
ID

Verify that the update is for the model of DR-HD100 it is being installed
on. An update is not cross-platform and must be installed on the model
for which it is intended.

To find the specific model of a DR-HD100 go to the SETUP
screen and then version (V 1.0.0), refer to “Setup Screens” on
page 62.
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UPGRADE ERROR

FILE
NOT FOUND

Verify that the upgrade file name is dr-hd.bin and that it is in the
DR-HD100 hard drive’s root directory.

System Reset

SYSTEM RESET

CONTINUE TO
RESET

SYSTEM?
YES BACK

The System Reset feature restores the factory default settings for the
DR-HD100 unit. This feature is useful for diagnosing problems with
the unit.

A System Reset

A System Reset can not be reversed.

Diagnostic
A DO NOT CHANGE THE SETTINGS OF THIS FUNCTION

This function is included to assist Focus Enhancement Technical
Support diagnose problems that may occur with the DR-HD100.
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Status

The DR-HD100 Status screen provides details of the systems power
state as well as internal temperature. This screen may assist Focus
Enhancements Technical Support in determining power and thermal
problems with your unit.
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Reels Screen

When a disk is formatted, the DR-HD100 creates 10 folders,
numbered 0-9, on the disk. During recording or playback of a clip, it
is possible to place it into folders or play it from up to 10 different
reels.

These folders can have any name up to 10 characters in length. To
name the folders it is first necessary to enter DD Drive mode and
mount the DR-HD100 to a computer.

Placing a Clip in a Reel

From the Reels screen, choose the Reels as follows:

Step 1:  From the Utilities screen, go to Reels screen.
Values include:
* FA RO0-0 Default Value

* FA R0-0 through R9-9 “Reel Name”

Step 2:  Select a reel from the list.

When selecting a REEL from this screen, the current track is
marked with that REEL number. This can be done in any mode:
record, stop, or playback.
Each of the function keys can be set to specific reel, making it
possible to quickly switch between multiple reels: a total of three
reels being the maximum. Refer to “Functions Screen” on page 70 for
more information.
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When using the optional wired remote control, use the button pad
numbered 0-9 to mark the clips. Any additional button presses during a
recording or playback, changes the selected REEL. Once a session is
finished, select ORGANIZE REEL in Utilities screen. The marked clips
are placed in the REEL in sequential order.

When a reel is selected, the Home screen menu displays the reel’s
name on the left side of the second to the last line of the screen, refer
to “LOCAL” on page 89.

Optional Wired Remote Control (p/n ACSS-0019-01)

To order the Wired Remote Control, go to Focus Enhancements website,
www.focusinfo.com/sales/store/.
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Play Screen

PLAY

PLAY CLIP
LOOP CLIP

LOOP ALL
PLAY ALL

* Play Clip
In this mode, the DR-HD100 plays the selected clip from
start to finish when you press the PLAY button. At the end of
the particular clip, the DR-HD100 pauses.

* Loop Clip
In this mode, the DR-HD100 plays the selected clip from
start to finish. Immediately after completing the clip, the DR-
HD100 begins playing the clip again without a pause. It stays
in this state until stopped.

e Loop All

In this mode, the DR-HD100 plays the entire contents of the
disk (all clips), in order, from start to finish. At the end of the
last clip, the DR-HD100 begins to play from the beginning of
the first clip again without a pause. It stays in this state until
stopped.

* Play All

In this mode, the DR-HD100 plays the entire contents of the
disk (all clips) in order, from start to finish. At the end of the
last clip, the DR-HD100 pauses.
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Play From Screen

PLAY FROM

TRACK LIST
REEL LIST

This screen permits the selection of from where clips playback.
There are two choices:
e Track List
Clips playback in the order in which they were recorded.
Playback order is based on the order of the file names.
* Reel List
Clips in a selected folder are played back. This function
provides the ability to choose between any folders on the

disk. Folders can appear with their user assigned folder name
(if used).
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Control Screen

LOCAL
-JVC GY-HD

SYNCRO SLAVE
AvVIC

The Control screen provides the capability of enabling the DR-
HD100 to operate in five different control modes during record and
playback.

» LOCAL
Local control mode ignores record triggers from the

camcorder and is controlled exclusively from the DR-HD100
front panel or the optional wired remote control unit.

Transport _|
Keys

Keeper
(cycles through
Reels)

STOP 1-001
COUNTER
00:00:00:00:
0-9 REEL —

DISK 1 000 min
numbers

R1
SYNC DISP LOCK

Transport keys have the same functions as on the DR-HD100.
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90

* Usethe Keeper ¢ key to cycle through the available Reels.
For example, if the current Reel selection is 3. pressing Keeper
changes the selection to Reel 4.

To purchase the wired remote control, p/n ACSS-0019-01, for

the DR-HD100, visit Focus Enhancements web site at

www.focusinfo.com/sales/store/.

JVC GY-HD

The JVC GY-HD control setting is the preferred mode when

using the companion GY-HD100/101 camcorder. See page 30

for more information about using the JVC GY-HD control

mode.

Syncro Slave

Use this mode when the camcorder does not have DR-HD100

compatible external control or the tapeless trigger

functionality. In Syncro Slave control mode, the

DR-HD100 mimics the camcorder’s operations by

monitoring the camcorder’s tape record state.

Av/C

Ohote

Do Not Use AV/C control in Record Mode

Use AV/C in playback mode and other situations where the
DR-HD100 is controlled by an external FireWire device such
as a NLE system that is not supported by Direct To Edit
Technology. In these cases, the DR-HD100 can be used in a
manner similar to a camcorder to capture footage to the NLE
External

The External Control mode allows the DR-HD100 to be
controlled from a camcorder other than the JVC GY-HD100/
101, if it features a DR-HD100 compatible external control
setting separate from the tape transport.

Ohote

Camcorder Requirements for External Control Mode

External Control mode will not work unless it is supported by the
camcorder and the camcorder is placed in this external control mode.
Please check your camcorder manual for more details.
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The table below shows the different symbols and states displayed on
the top line of the LCD when used with different DR-HD100 control,
record, play and stop modes:

PLAY/REC MODE DR-HD100 LCD CAM EVF/LCD

Stop STOP S white *

Pause Il PLAY P blink white *

Play P PLAY P white *

Rec (Pause) I REC see table next
page

Normal Rec (Rec) REC see table next
page

Retro Disk (Stop) L STOP S white *

Retro Disk (Standby) L REC L blink red

Retro Cache (Stop) C STOP S white *

Retro Cache (Standby) C REC C blink red

Loop Record (Stop) O STOP S white *

Loop Record (Rec) O REC Ored

Loop Record (Standby) I OREC O blink red

Snap (Stop) STOP S white *

Snap (Standby) I SNAP G blink red

Snap (Rec) Il SNAP G red
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PLAY/REC MODE
Time Lapse (Stop)
Time Lapse (Pause)
Time Lapse (Rec)
AV/C* (Stop)

AV/C* (Rec Pause)
AV/C* (Rec)

AV/C* (Play Pause)
AV/C* (Play)

JVC GY-HD (Pause)
JVC GY-HD (Rec)
Syncro Slave (Pause)
Syncro Slave (Rec)
External (Pause)

External (Rec)

DR-HD100 LCD

STOP
TREC

O TREC

A STOP

A<REC TYPE>REC
A<REC TYPE>REC
A PLAY

A PLAY

J<REC TYPE>REC
J<REC TYPE>REC
Y<REC TYPE>REC
Y<REC TYPE>REC
E<REC TYPE>REC
E<REC TYPE>REC

CAM EVF/LCD
S white *

T blink red

T red

S white *

R blink red

R red

P blink white *
P white *

see table below

see table below

* There is o CAM EVF/LCD Status Display when the GY-HD100/101 is in VTR

mode.

AV/C* Only for use when the DR-HD100 is connected to a computer system.

GY-HD100 1394 REC Trig Mode

GY-HD REC TRIG Mode Record State CAM EVF/LCD
Off REC R red

REC Pause R blink red
Syncro REC Y red

REC Pause Y blink red
Split REC R red

REC Pause R blink red
Series REC F red

REC Pause F blink red
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Technical Specifications

Specifications are subject to change.

Physical Description

* Dimensions: 1.59" x 5.6" x 3.74" (40mm x 142mm x 95mm)
(with normal 90 minute Battery)

*  Weight: 1 Ib. (.45 kg)

Input/Outputs

* DV Video I/O - 25Mb/s (1x 6-pin IEEE-1394)
In HD RECORDER mode the unit accepts 720P and 10801
MPEG video from specially equipped camcorders.

*  FireWire Computer I/F - up to 400Mb/s (1 x 6-pin IEEE-
1394)

*  GPI & RS-232C Control (1 x 3.5mm mini jack)

Power
« 15V DC, 7.5W
*  Mini-jack power connector

* Custom Removable Li-ion Rechargeable Battery Pack (90
minutes estimated run-time)

Audio/Video/Timecode Specification

s  25Mb/s, 8-bit 4:1:1 (NTSC-DV) or 4:2:0 (PAL-DV) video
(model dependent). The HD RECORDER mode supports
720p (24/25/30) and 10801 (50/60) from HDV camcorders
with a 1394 interface.
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Technical Specifications

* DV Embedded Timecode (Drop or Non-Drop)

e DV audio: embedded 2-channel (16-bit, 48kHz) or 2-channel
(12-bit, 32kHz) Audio. 4-channel (12-bit, 32kHz) is available
for RawDV format only.

* HD audio: MPEGI1 Audio Layer II.

DTE File Formats

* DV mode: Raw DV, AVI Type 1, AVI Type 2, Matrox AVI,
Canopus AVI, QuickTime, AVID OMF, AVI Type 2 24p
(NTSC only), QuickTime 24p (NTSC only), Pinnacle

e HD mode: M2T

Disk Information
* Internal Disk Type: 40GB (or 80GB), 5400RPM, 8 MB cache
¢ Disk Format: FAT32

*  DR-HD100 compatible with Windows 98SE, ME, 2000, XP
and Mac 0S9/10.

Log Files

With each recording of a particular clip on a disk, the DR-HD100
creates a text log file to identify information about the recorded clip
and the recording session. Information includes:

* Clip name

*  Clip in/out source TC values
*  Clip duration

*  Clip type (record file type).

The log file also identifies when the shock cache becomes low and
when disk or other errors occur during a recording.
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Technical Specifications

Error Messages

Error messages may appear on the DR-HD100 LCD display from
time to time. The purpose of these messages is to alert you to action
that may effect your DR-HD100 operation. Below is a list of error
messages and actions you can take:

Error Message

Description

Action

LOW BATTERY! Battery power is low. Connect AC Power or replace the bat-
tery pack. When the unit is run without
the battery installed, this warning can
be displayed, that is normal.

HIGH The unit is getting too hot Make sure the vent and fan intake

TEMPERATURE! for normal operation. holes are clear.

NO SPACE LEFT!

The Disk Drive is Full.

Transfer files off the drive and format it
before attempting to do more record-

ing.

DISK ERROR Lost Disk Communication. Contact Focus Enhancements Techni-
XXX cal Support.

NO DISK Lost Disk Communication. Contact Focus Enhancements Techni-
DETECTED cal Support.

WRONG Incorrect Software Loaded. Download correct software and per-
PRODUCT ID form upgrade again.

FILE NOT FOUND

Wrong filename or missing
file.

Check filename or that upgrade file
exists.

TRK LIMIT MAX!

999 clips exist on system.

Copy content from DR-HD100 hard
drive and re-format.

Warranty

* 2years, DR-HD100
* 90 Days Accessories including the battery.

Temperature
e Operating: 0-40° C (32 - 104° F)

*  Operating humidity: 30% to 90% RH
* Storage temperatures: -20 to 60° C (-4° to 140°F)
*  Storage humidity: 85% RH or less

ProHD DR-HD100 Portable DTE Recorder
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Compatible Camcorders and Accessories

For a list of tested camcorders, refer to www.focusinfo.com.
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